D-Link DP-G310
AirPlus G
Wireless USB Print Server

Manual

D-Link

Building Networks for People



Contents

Package CONENTS .........uuuuuiiiiiie et e e e e e e e e e e e e e e e e aeeeannnes 3
INEFOTUCTION ... e e e e 4
WIFEIESS BASICS ....veeeeiieeiiiiiiti ittt 8
Installation CONSIAEratioNS ............cooiiiiriiiiiiee e 9
Setting UP the DP-G310 .....ccooiiieeiicie e 10
POWETN ON SEIFTEST ... 11
Using the Web Configuration ............cooevveviiiiiiiieeeceeeeeeee e 12
TCP/IP Printing for WINAOWS XP .....oiiiiieiiieeeeeeie e 30
TCP/IP Printing for Windows 2000...........cuuuiiiiiiiieeeeeeeeeeeiee e 39
TCP/IP Printing for Windows 98SE/Me ..........ccceiiiiiiiiiiiiieee, 49
Unix/Linux Printing (See PS Admin Manual on CD-ROM)................... 61
Setting up AppleTalk or LPR Printing In MAC OSX .......cccovvivvvvviiiinnnnnn. 62
Setting up AppleTalk Printing IN MAC OS9 .........cceiiiiiiieeeieeeeen, 67
Printing from Mac OS Client Workstation.............cccceevvvvevvviiiiiiie e, 68
NEtWOrKING BASICS .....ccvveviiiiiiiiiie e eeeee e e e e e e e e e e e e e 70
Technical SPecCifiCations ............uuueiiiiie e 82
Contacting Technical SUPPOIT .........ooveiiiiiiiie e 83
Warranty and RegiStration ...........ccccoeviiiiieiiiiiiiiiie e 84

Appendix: DP-G310 Printer Compatibility LiSt.............cccovvvvvriiiiiinnnnnnn. 87



Package Contents

Contents of Package:

B D-Link DP-G310 Wireless USB Print Server
B Manual and Warranty on CD
m Printed Quick Installation Guide

If any of the above items are missing, please contact your reseller.
System Requirements:

B A computer with an installed Ethernet adapter for initial
configuration purposes only

B Windows XP/2000/ME/98SE, Mac OS with AppleTalk , or
Linux

m A computer or a network of computers with wireless
capability

B Internet Explorer 6.0, or Netscape Navigator version 6.0 or
above, with JavaScript enabled

m The printer must support the required Operating System




Introduction

The D-Link DP-G310 Print Server is an 802.11g wireless USB 2.0 high-speed
Print Server that can also connect to your Ethernet/Fast Ethernet network. Now
you can locate USB printer services virtually anywhere in your home or office.
The DP-G310 manages the flow of print files from workstations or file servers to
connected printers, delivering print jobs to printers much faster than a file server
on a PC. With one USB 2.0 port, the DP-G310 can connect to almost any printer
with a USB port.

The DP-G310 includes easy-to-use software to install on most Windows-based
networks. Protocol support for TCP/IP, NetBEUI, and AppleTalk are provided to
ensure seamless connection to major networking operating systems.

The DP-G310 has a built in Web-based management feature that allows users to
easily configure and manage print queues through TCP/IP. The DP-G310 also
supports Telnet as an alternative method to configure the unit.

The DP-G310 improves network printing services in the following ways:

B The DP-G310 delegates print jobs to the connected USB printer. This
provides workload relief to your file servers and allows the file servers’ full
capacity to be used for file access or other direct services to network
users. On peer-to-peer networks, workstations can print directly to the
Print Server without increasing the load of another workstation or server.

B The DP-G310's USB 2.0 port can transmit data to high-speed
laser printers much faster than a PC’s parallel printer port.

B Because the DP-G310 is very portable and inexpensive compared to a
PC-based print server, and the Print Server connects to your file servers
through the network, printers can be deployed to locations of maximum
convenience to users.



The DP-G310 offers extraordinary flexibility, operating with all major network
operating systems and protocols:

u TCP/IP
UNIX Ipr/lpd

Windows NT/2000, Windows 95/98SE/ME, Windows XP
NetWare 5.x NDPS LPR Remote Printing

] NetBEUI
Windows 2000/XP, Windows 95/98SE/ME, Microsoft LAN
Manager, IBM LAN Server

m AppleTalk
MacOS EtherTalk

Windows-based setup and administration software, PS Admin, is supplied with
the Print Server, making configuration and management quick and easy. The
Print Server also supports configuration and management via the Telnet protocol
for networks without Windows-compatible systems.

External Features

Port Connectors

The DP-G310’'s USB port is located on its rear panel. The USB can be configured
using the PS Admin program or the print server’s Telnet interface. (See the PS
Admin User’s Guide, available on the CD that came with the DP-G310, for
information about configuring the print server’s ports.) The Print Server also
supports web configuration permitting users to configure settings through the web
browser. The default IP Address is as follows:

| Default IP Address —192.168.0.10

| Subnet Mask —255.255.255.0

Note:

The PC’s IP Address must be in the same subnet as the Print Server’s IP Address for the
two devices to communicate. (For example, if your Print Server’s IP Address is
192.168.0.10, with a subnet mask of 255.255.255.0, then your computer’s IP Address
should be 192.168.0.x, where x is a value between 1-254, excluding 10.)




Front Panel LED Indicators

There are two front panel indicators, each holding two separate LEDs (aligned in a
vertical position). As shown below, the first indicator holds the Power and the USB
LED. The second indicator holds the Ethernet and WLAN LED. Upon boot-up, the
Power light stays on continuously and all other LEDs light up momentarily one-by-
one, then turn off.

B Power

A steadily lit LED indicates proper operation of the Print
Server.

B USB

A steadily lit LED indicates your USB printer is printing;
otherwise, this LED is off.

B Ethernet

A steadily lit LED indicates proper network connection; no lit
LED indicates an unsuccessful network connection. A blinking
LED indicates activity (configuration or printing).

B WLAN

A steadily lit LED indicates a proper wireless network
connection; no lit LED indicates an unsuccessful wireless
network connection. A blinking LED indicates activity
(configuration or printing).

Power

Ethernet

WLAN

USB




Rear Panel Connectors

Network Cable Connector

The Print Server’s rear panel has a LAN port for CAT5 Ethernet
cabling. The port supports the NWay protocol, allowing the Print
Server to automatically detect or negotiate the transmission
speed of the network.

DC Power Connector

The DC power input connector is located on the Print Server’s
rear panel and is labeled DC 5V.

Antenna

Power

Reset

USB

LAN




Wireless Basics

D-Link wireless products are based on industry standards to provide easy-to-use
and compatible high-speed wireless connectivity within your home, business or
public access wireless networks. D-Link wireless products will allow you access to
the data you want, when and where you want it. You will be able to enjoy the
freedom that wireless networking brings.

A wireless LAN (WLAN) is a cellular computer network that transmits and receives
data with radio signals instead of wires. WLANS are used increasingly in both home
and office environments, and public areas such as airports, coffee shops and
universities. Innovative ways to utilize WLAN technology are helping people to work
and communicate more efficiently. Increased mobility and the absence of cabling
and other fixed infrastructure have proven to be beneficial for many users.

Wireless users can use the same applications they use on a wired network.
Wireless adapter cards used on laptop and desktop systems support the same
protocols as Ethernet adapter cards.

People use wireless LAN technology for many different purposes:

Mobility - Productivity increases when people have access to data in any location
within the operating range of the WLAN. Management decisions based on real-
time information can significantly improve worker efficiency.

Low Implementation Costs — WLANS are easy to set up, manage, change and
relocate. Networks that frequently change can benefit from WLANs ease of
implementation. WLANS can operate in locations where installation of wiring may
be impractical.

Installation and Network Expansion - Installing a WLAN system can be fast and
easy and can eliminate the need to pull cable through walls and ceilings. Wireless
technology allows the network to go where wires cannot go - even outside the
home or office.

Scalability — WLANs can be configured in a variety of topologies to meet the
needs of specific applications and installations. Configurations are easily changed
and range from peer-to-peer networks suitable for a small number of users to
larger infrastructure networks to accommodate hundreds or thousands of users,
depending on the number of wireless devices deployed.

Inexpensive Solution - Wireless network devices are as competitively priced as
conventional Ethernet network devices.



Wireless Basics (cont.)

Standards-Based Technology

Based on the IEEE 802.11g standard, the DP-G310 is interoperable with existing
compatible 2.4GHz wireless technology with data transfer speeds of up to 54Mbps
when used with other D-Link AirPlus G devices.

Installation Considerations

The D-Link AirPlus G DP-G310 lets you print through your network, using a
wireless connection, from virtually anywhere within its operating range. Keep in
mind, however, that the number, thickness and location of walls, ceilings, or other
objects that the wireless signals must pass through, may limit the range. Typical
ranges vary depending on the types of materials and background RF (radio
frequency) noise in your home or business. The key to maximizing wireless range
is to follow these basic guidelines:

1. Keep the antenna of the DP-G310 in an upright position.

2. Keep the number of walls and ceilings between the DP-G310 and other
network devices to a minimum - each wall or ceiling can reduce your D-Link
wireless product’s range from 3-90 feet (1-30 meters.) Position your devices
so that the number of walls or ceilings is minimized.

3. Beaware of the direct line between network devices. Awall that is 1.5 feet thick
(.5 meters), at a 45-degree angle appears to be almost 3 feet (1 meter) thick. At
a 2-degree angle it looks over 42 feet (14 meters). Position devices so that the
signal will travel straight through a wall or ceiling (instead of at an angle) for
better reception.

4. Building materials can impede the wireless signal - a solid metal door or
aluminum studs may have a negative effect on range. Try to position wireless
devices and computers with wireless adapters so that the signal passes
through drywall or open doorways and not other materials.

5. Keep your product away (at least 3-6 feet or 1-2 meters) from electrical
devices or appliances that generate extreme RF noise.



Setting up the DP-G310

Installing the Print Server

WARNING: Configuration problems may result if the Print Server is powered up without

first establishing its network connection. Follow this procedure to avoid complications at
the configuration stage.

1. Confirm proper operation of your printer before connecting the DP-G310.

2. When you have confirmed proper operation of your USB printer, turn your
printer power OFF.

3. Confirm that your network is operating normally.

4. Connect the DP-G310 to your network, using a straight-through CAT5 cable.

5. While the printer is powered OFF, use the USB printer cable to connect the
DP-G310 to your USB printer.

6. Switch ON your USB printer.

7. Plug the DC power adapter into the DC 5V power socket on the rear panel of
the Print Server.

8. Plug the power adapter into a power outlet. This will supply power to the DP-
G310, as it has no external power switch. The green Power LED on the Print

Server’s front panel should illuminate steadily, and the Print Server’s Self-
Test will proceed.



Power ON Self-Test

Every DP-G310 has been factory-tested to operate properly.

When the DP-G310 is powered ON, it also automatically performs a Self-Test on
each of its major components. The final result of the Self-Test is signaled by the
state of the USB LED indicator following the Self-Test. Preliminary to the actual
component tests, the LED indicators are tested to confirm their steady and flashing
operation.

Immediately after power-up, three of the green LEDs should illuminate steadily for
several seconds. Then the USB LED should flash three times. Irregularity of the
LED during this LED test may mean there is a problem with the LED itself.

The actual component tests immediately follow the LED tests. A normal (no fault)
result is signaled by a flashing of the USB LED, followed by a darkened LED.

If the Self-Test routine detects any component error, then following the LED tests
the Self-Test will halt and the LEDs will continuously signal the error according to
the following table.

r ~
USB LED Faulty Component
low speed flashing Need to reload firmware
steady ON DRAM error
1llong 2 short Timer INT error
1llong 3short Flash Protected
llong 5 short Flash Erase/Program error
1llong 6 short LAN Controller error
1llong 7 short LAN memory error
1long 11 short LAN I/O base error
1long 15 short Wireless LAN card detect error
1long 16 short Wireless LAN card CIS error
1long 17short Wireless LAN card I/O error

L 1long 18 short USB error J




Using the Web Configuration

Please use an Ethernet connection for the configuration of the DP-G310. Using a
CAT5 cable, connect the DP-G310 to the Ethernet-adapter equipped computer in
your network that you will be using for configuration. Open your web browser and
type http://192.168.0.10 in the address box, and press Enter. This set of numbers
is the default IP Address of your Print Server. Please note that the PC's IP
Address must correspond with the Print Server’s IP Address in the same
segment for the two devices to communicate.

File Edit View Favorites Tools  Help

DREEAIP

Address | @] Rt 1192, 168.0,10

When you enter the default IP address, the main screen of the Print Server’'s con-
figuration will appear (see below). In addition to the product information, you can
access and control the Print Server’s configuration through four links on the top of
this main screen: Home, Configuration, Tools, and Help.

- .
Lol t br-c310
AirPlus G Wireless USB Print Server

L Configuration] _Tools 1 Help
Device Status
Server Name DPG-301U
Model DP-6310
Firmware Version 1.00c (2003-12-29)
MAC Address 00FF60121B26
SFDD 1P Address 192.168.0.10 (Manual)
Up Time 0 days, 00:00:08

%

Wireless Printer Status
use Printer Name DPG-301U

— Printer Speed Full Speed (12M bps)
Network Printer Status offline

[—— Total Print Jobs 0
User Total Print Size 0KBytes

JERG

Printing Status dle
Name
MAC
P
Protocol
Spooling Size 0 Bytes
Printing Size 0Bytes

Ethernet Status

Link Yes
Speed 100M bps
Duplex Yes

Tx Packets 17
TxEnrors 0
RxPackets 2%
RxErors 0

Refresh




Using the Web Configuration (continued)

Home

Click on the Home tab from the tools bar of the main screen to display information
about the DP-G310's System Status and Printer Status.

Home > System

As shown below, the System displays the status of your print server, printer and
network. Clicking Refresh will update the information.

DP-G310

A/rPlus G Wireless USB Print Server
Home Configuration Tools m
==
~g Device Status
Server Name DPG-301U
Model : DP-G310
Firmware Version © 1.00c (2003-12-29)
MAC Address 00FFB0121B 26
S IP Address © 192168.0.10 (Manual)
Up Time : 0 days, 00:00:08
e
T
USB  : Printer Name : DPG-301U
— Printer Speed : Full Speed (12M bps)
Network Printer Status : Offline
— Total Print Jobs 0
User Total Print Size :© OKBytes
Printing Status : o ldle
Name
MAC
P
Protocol
Spooling Size : 0 Bytes
Printing Size  : 0Bytes
Ethernet Status
Link © Yes
Speed : 100M bps
Duplex Yes
TxPackets 7
TxErmors 0
Rx Packets © 28
RxErrors 0
Refresh

Device Status: Information about the print server, including the firmware version,
MACI/IP address, and the “up time” can be found in this field.

Printer Status: The items in this field display information about the printer, such as
the given name of the printer, speed, printer status, and the status of your printing
tasks, etc.

Ethernet Status: You can monitor the networking status in this field, including the
network connection, speed, and the packets status.



Using the Web Configuration (continued)

Home > Wireless
Click the Wireless button in the left column to display information about the
wireless LAN. Clicking Refresh will update the information.

D-Link DP-G310

Building Networks for People

A/rPlus (G Wireless USB Print Server

| Configurationd _Tools 1 _Help

Home
Wireless Status
Connection Mode : Infrastructure
Link ©Yes
j=1=1[n} o default (MAC 0003 1B 00 CE B3)
Channel A |
System Transmission Rate © 11Mbps
WEF Encryption . Disahle
i Ty Packets S 438
Tx Errors o

Rx Packets 12288
Network Ry Errors S

User

i

Wireless Status: The items in this field display information about the wireless LAN,
such as the connection mode (Infrastructure or Ad-Hoc), SSID, channel, data
transfer rate, WEP encryption, and the packets status.



Using the Web Configuration (continued)

Home > Network

Click the Network button in the left column to display information about the wireless
LAN. Clicking Refresh will update the information.

Building Networks for People DP-G310
AjrPlus G Wireless USB Print Server

Home Configuration Tools m
- Auto I
DHCPIBOOTP Disable  (P:0.00.0)
UPnP Enable (P :132.168.1.106)
999999999
MAC Rendezious 19997y (F0000)
—
TCPAP Printing
LPR Printing Status Running
———
Wireless Total Print Jobs < 0
Total Print Size 0 KBytes
Port (3100) Printing Status Running
Hethor Total PrintJobs 0
Total Print Size 0 KBytes
Po——— 1P Printing Status Runing
User
Total Print Johs  : 0
Total Print Size 0 KBytes
FTP Printing Status Running
Total Print Jobs 1 0
Total Print Size 0 Keytes
E-mail Printing Status Running
Total PrintJobs  © 0
Total Print Size 0 KBytes
Microsort Network Printing
SMB (Over NetBEU) Printing Status Running
Total Print Jobs  © 0
Total Print Size 0 KBytes
SMB (Over NBT) Printing status Running
Total Print Joks  : 0
Total Print Size 0 KBytes
MAC AppleTalk Printing
AppleTalk Printing Status Running

Total PrintJobs 0
Total Frint Size 0 KBytes

Auto IP: This field contains the current settings of TCP/IP, including DHCP/
BOOTP, UPnP, and MAC Rendezvous. The items in this field are configured in
Configuration>Network>TCP/IP.

TCP/IP Printing: In this field, you can monitor the status of your printing tasks
through TCP/IP.

Microsoft Network Printing: In this field, you can monitor the status of your
printing tasks through Microsoft Network.

Mac AppleTalk Printing: In this field, you can monitor the status of your printing
tasks through Mac AppleTalk.



Using the Web Configuration (continued)

Home > User

Click the User button in the left column to display the user’s information.

D-Link
Building Networks for People DP-G310
AirPlus G Wireless USB Print Server

Home m

Users Printing Log

|| mac G | Narme ldobs | Size(kBytes) |

System @

Refresh

Wireless

Network

User

/[ ¢

Users Printing Log: The items in this field display the user(s) information, which
include the user(s) Mac address, IP address, name, and status of printing tasks.



Using the Web Configuration (continued)

Configuration

Click on the Configuration tab from the tools bar of the main screen to enter the
configuration page; it provides the configuration options that include System De-

vice and Port Setting

System Device and Port Setting

This option will show you settings required to configure the DP-G310 Print Server.
Consult your printers owner manual for the PJL(Printer Job Language) and print
speed supported on your printer. Click the Save button on the bottom of the con-

figuration page to ensure the settings are updated and saved.

D-Link

Building Networks for People

DP-G310
A/rPlus G Wireless USB Print Server

Configuration -!l!ﬂ

System Device

Server Mame

Location

Admin Contact

Pasgword

Wireless
Port Setting

USB
Network

User

SHMP

UEEE

: PortMame

Description

F.JL Frinter

IDPG~301U
D Mew Password . [FERE
Confirm Again [k

. [pPE3010

CMe +

9 9

Apply Cancel




Using the Web Configuration (continued)
Configuration > System Device and Port Setting

System Device

In this field, you can configure the basic information of your print server.

Server Name: Assign a name to the print server.

Location (optional): Assign a location for the print server.

Admin contact (optional): Assign the Admin’s contact name for the print server.

Password: Enter the Administrator password (3-8 characters). To set up the
password, please enter the password in the New Password box, and then enter
the same one again in the Confirm Again box.

Port Settings

In this field, you can assign the Port Name for the print server, and the description
for the USB port. It also allows you to select the PJL Printer setting (Yes or No).

NOTE: PJL (Print Job Language) has certain job requirements that must be met to
work correctly. for more information, please refer to your printer’s manual.

Configuration > Wireless

Building Networks for People DP-G310
A/rPlus G Wireless USB Print Server

Wireless Interface

configuration T BT
Ji .

Connection Mode @ Infrastructure
€ Ad-Hac

580 [Befinde (Manually Input or Select rom List
——
System default >
Site Survey
Wireless Witeless Channel 6 =
T Rate Fully Anwroatic ~
[ —
Network WEP Encryption
WEP Encyption @ Disable © G4bits © 128 bits
e WWEP Key Format @ pscil O HEX
User
Key 1 [
e Key2 [
SNMP
Key3 [
Key4 [
Encryot Data Transmissions Using ;| Fes 1 =
Advanced Setting
Beacon Intenval o (ms)

Preamble @ Long " shont

Authentication Type @ Open System C Shared Key © Bath

9 O

Apply Cancel




Using the Web Configuration (continued)
Configuration > Wireless

Wireless Interface
Connection Mode: Select one of two connection modes:

u Infrastructure (default): Connect to an existing wireless AP or
router in a WLAN.

| Ad-Hoc: Connect to wireless clients in the Peer-to-Peer mode.

SSID: Assign the SSID in this box. You can manually input the name or select one
from the pull-down menu. To search the available print server within the network,
click the Site Survey button.

Wireless Channel: Select the channel from the pull-down menu. The default
setting is 6.

Transmission Rate: Select the data transmit rate from the pull-down menu. The
default setting is Fully Automatic.

WEP Encryption
This field allows you to configure the settings of data encryption. Please remember
that the WEP key must be set before the data encryption is enforced.

WEP Encryption: This option allows you to select Disable, 64-bit, and 128-bit for
encryption setting.

WEP Key Format: You can decide the network key to be encoded by ASCII (ASCII
characters) or HEX (hexadecimal digitals). 64-bit WEP encryption uses a 10
hexadecimal character key. The WEP encryption key must match the WEP
settings on your AP or wireless router to connect properly.

Then, enter the key(s) for the network in the Key box (1-4).

Advanced Setting
Beacon Interval: Enter the number for the beacon interval in milliseconds.

Preamble: This option allows you to set the length of the preamble. Setting options
are:

u Long: set to 144 bits

u Short: set to 72 bits.

Authentication Type: You can set the authentication type by selecting the settings:
Open System, Shared Key, and Both.



Using the Web Configuration (continued)

Network

D-Link
Building Networks for People DP-G310
A/rPlus G Wireless USB Print Server

Configuration [EEETI T

TCPAP
IF Address

& Manually Assign

IP Address : |19Q.168.0.10
SubnetMask - [255.2552550
System
Default Gateway - I0.0.0.0

|  automatically Assign

Wireless DNS Server Address 0,000
5 [0600

Network UPHP . @ Enable © Disable

[

MAC Rendezvous . U Enable © Disahble
Second HTTP Part © " Enahle * Disahle

Part Mumber : IO

(For Remaote Weh Configuration and IPP Printing)

User

0]

s Microsoft Network

Winrkgroup . IWORKGROUP

AppleTalk

AppleTalk Zone ; I*

UsB : Chooser Mame : DPG-301U
Printer Type : |L33&rWriter
PostScript Level - |Level2 -
Font Group - | Standard 35 -

9 9

Apply Cancel




Using the Web Configuration (continued)

Configuration > Network

TCP/IP

This field contains three options that allow you to configure the TCP/IP setting:

IP Address: This option allows you to set the IP address manually or automatically.
When you choose Manually Assign, you should enter the related information in the
following boxes, including IP Address, Subnet Mask, and Default Gateway.

UPnP: This option allows you to enable or disable UPnP mode.

MAC Rendezvous: This option allows you to enable or disable MAC Rendezvous
mode.

WEP Encryption: This option allows you to select Disable, 64-bit, and 128-bit for
encryption setting.

Microsoft Network

Enter the name of the Workgroup that you want the print server associated with in
this field.

AppleTalk

Enter the AppleTalk Zone name in the box. In the following options, enter the related
configuration, such as the printer type.

USB

Chooser Name: Display the print server name.
Printer Type: Enter the printer’s type in this box.
PostScript Level: Select from the pull-down menu (Level 1 or Level 2).

Font Group: Select from the pull-down menu.

TIP: Once you have changed the settings in each option, click Apply to store the
settings.




Using the Web Configuration (continued)

Configuration > User

D-Link
Building Networks for People DP-G310
A/rPlus (G Wireless USB Print Server

[ Home MNENTMETTM  Tools | Help

Printing Control
Enahle User Printing Cantrol Cyes Mo a @
Apply Cancel
—
System Define Users

AddUser @ UserName | Add |
MAC Address ¢ |
Printing Access  © @ yes O Mo

Delete User I vl Delete |

UserList ; | |Narr|e MAC ‘ Printing Access ‘

User

Printing Control
By configuring the Enable User Printing Control option (Yes or No), the user in
the User List is permitted to access the print server or not.

Define Users

You can add/delete the user(s) to/from the User List. The User List at the bottom
of the screen displays the current defined user and related information for the
print server.

Click Apply to save the changes.



Using the Web Configuration (continued)

Configuration > SNMP

D-Link
Building Networks for People DP-G310
A/rPlus (G Wireless USB Print Server

| Home MMVSITMECM  Tools d  Help

SHMP Management

Community 1 Mame : Ipubhc—
Access Right : IW
Community 2 Mame : I—
Access Right : lm
Community 3 Mame : I—
el Access Right : lm

Network a 8

Apply Cancel

System

-
-
-

User

SNMP

SNMP Management
SNMP (Simple Network Management Protocol) is a set of protocols for managing
complex networks.

Community 1/2/3: Enter a name in the Name box,
and configure the Access Right
by selecting Read Only or Read/Write
from the pull-down menu.

Click Apply if you have made changes.



Using the Web Configuration (continued)

Tools

Click on the Tools link from the tools bar of the main screen to enter the Tools
Page; it provides the control options that include Print Test , E-mail, Reset,
Upgrade, and Backup.

Tools > Print Test

D-Link

Building Networks for People

DP-G310
AirPlus (G Wireless USB Print Server

|__Home _J Configuration JENNRCYIR  Help

Print Test
Fort Selection

+ UsH
USE port print test requires Mative DOS mode support on yvour printer.

Print Test g

Apply

E-mail

Reset

Upgrade

Backup

i

Print Test
Click Test to print a test page.



Using the Web Configuration (continued)

Tools > Email

DP-G310
AirPlus G Wireless USB Print Server
Configuration SRR Help
“‘ E-mail Account
PHint Server E-mall Address [Tack_Wro@dlink com v
Incaming E-mail (POP3) Server Address [k com.tw
T .
Outgoing E-mail (3MTP) Server Address |n|hnkmtw
Account Mame © [Jack_Wu
.
@ 9
—
Geiline
E-mail Notification
Upgrade Enable e-mail notification for printer status changing @ & yves © no
Admin E-mail Address Ijaﬁk_w“@m‘mw‘
T (Use 't separate multiple e-mail address)
Backup
@ 9
Apply Cancel
E-mail test will send an e-mail to Admin's e-mail address Test
Do you want to test e-mail aceount?
E-mail Printing
E-mall Printing ©  Enable © Disable
Receive E-mail Interval [5 (minutes)
9 O
Apply Cancel
Do you want to receive e-mail and print out? Recetve

E-mail Account

You can assign an E-mail address to the print server, so that the mail from the
account can be printed out directly through the printer (ASCII test only). To enable
this function, enter the E-mail account in the Print Server E-mail Address box.

Incoming E-mail (POP3) Server Address: Enter the server address that is
used to receive your E-mail in this box.

Outgoing E-mail (SMTP) Server Address: Enter the server address that is
used to send your E-mail in this box.

If your mail server needs to verify the user when sending E-mail, the DP-G310 will
apply the same Account Name and Password to the mail server as it does when
receiving E-mail.



Using the Web Configuration (continued)
Tools > Email (continued)

E-mail Notification

You can set the print server to send a message through E-mail when the printer
status changes. To enable this function, set the Enable e-mail notification

for printer status changing option to Yes. Then, input the administrator’s Email
addressinthe Admin E-mail Address box.

E-mail Printing

E-mail Printing (ASCII Text Only): Select Enable to enable the E-mail printing
function.

Receive E-mail Interval: Enter the number in this box to set up the time (in
minutes) to check/receive E-mail regularly.

Test E-mail Account: Click Test to send a test E-mail to the given
administrator's Email address.

Receive E-mail: Click Yes to immediately check and receive E-mail, and then
print out the mail when available.

Reset
- :
D Link or-ca10
AirPlus G Wireless USB Print Server
Reset o e
CIICk Apply to “ R[?;::u want to resetthis device?
immediately reset )
the print server. Apol
Factory Reset
FaCtO ry Res et - Do you want to restore this device to factory default setting?
E-mail

Click Apply to gv
reload the factory
settings of the print

=)
server.

=]




Using the Web Configuration (continued)
Tools > Upgrade

 D-Link'

Building Networks for People

DP-G310
AirPlus (G Wireless USB Print Server

[__Home _J Configuration JENNRCESNN  Help

Upgrade

Mote: Please make sure thatyou use the correct firrmware before you proceed. Ifyou do not
know which firmware you should use, please contactyour lacal dealer far technical support.

Current Firmware Yersion and Date: 1 .00¢c (2003-12-29)

Print Test

-
-
-

Select A Firmware File
E-mail a a

Apply Cancel

Resat

Upgrade

|

Backup

Firmware Upgrade

When a new version of firmware is available (e.g., downloaded from the
manufacturer’s website), you can upgrade the firmware of your print server. Click
Browse to locate the firmware file, then click Apply.



Using the Web Configuration (continued)

Tools > Backup

D-Link

Building Networks for People

DP-G310
AirPlus (G Wireless USB Print Server

oo [ITTEIR

Backup Device Configuration to File
Do you want to backup the configuration to file?

V)

Apply
g
Print Test Restore Device Configuration from File
Select A Configuration File | Browse.. |
E-mail
Apply Cancel

Upgrade

Backup

Backup Device Configuration to File
Click Apply to backup your current configuration of the print server to file and then
save in the computer.

Restore Device Configuration from File
You can reload a configuration that you saved before. Click Browse to point to
the backup file, and then click Apply.



Using the Web Configuration (continued)
Help

D-Link
Building Networks for People DP-G310
AirPlus G Wireless USB Print Server

|__Home ] configuration] __Tools Y

Help

For US customer support, please visit us anline at htpafsuppart dlink.com

Home
System
Wireless
MNetwork
User

Configuration
System
Wireless
MNetwork
User

SHMP

Tools
Frint Test
E-mail
Reset
Upgrade
Backup

Click on the Help link from the tools bar of the main screen to enter the Help Page.
It provides a link to D-Link’s support website. D-Link’s support website will provide
the most up to date information on your DP-G310 Print Server. Please check the
website regularly for product and firmware updates.



TCP/IP Printing for Windows XP

Open the web browser, and type in the IP Address of the DP-G310.
For example, type http://192.168.0.10 into the Location or Address field. Press
the Enter or (Return) Key.

Note:

The PC’s IP Address must be in the same subnet as the Print Server’s IP
Address for the two devices to communicate. (For example, if your Print
Server’s IP Address is 192.168.0.10, with a subnet mask of 255.255.255.0,
then your computer’s IP Address should be 192.168.0.x, where x is a value
between 1-254, excluding 10.) See Networking Basics: Assigning a Static IP
Address in this manual to find out how to change an IP Address.

File Edit ‘Wiew Favorikes Tools  Help

0 M@ )

Address | &] hitp:)192,168.0,10

Building Networks for People DP-G310
A/rPlus G Wireless USB Print Server

Home Configuratiol Tools m
-~ Device Status
Server Name DPG-301U
Model DP-G310

Firmware Version 1.00¢ (2003-12-29)
MAC Address 00FF 60121826

1P Address 192.168.0.10 (Manual)
Up Time 0 days, 00:00:08

rnter Status

uss Printer Name DPG-301U

[ — Printer Speed Full Speed (12M bps)
Networic Printer Status offline
r— Total Print Jobs 0
oeen Total Print Size 0KBytes
e

Printing Statt i
Nami
MAC
P
Protocol
Spooling Size 0By
Printing Size 0By
Ethernet Status
Link Yes
Speed 100M bps.
Duplex Yes
TxPackets 17
TxErors 0
Rx Packets 2%

RxEmors 0




TCP/IP Printing for Windows XP (continued)

At the Configuration window, write down the Port Name for future reference.
You will need this information later in the configuration process.

D-Link

Building Networks for People

DP-G310
AirPlus (G Wireless USB Print Server

| Home MNNTMETSE  Tools 4 Help

System Device
Server Narme : IDPGSOIU
Laocation 2 |

Admin Contact : |

System

= Password . New Password ;l****

Confirm Again : I****
I 2
Wireless
Port Setting
I Usa Port Name : |DPGSOIU
Network
Description
am— PJL Printer S |Ho -
User
— Q
SNMP Apply Cancel




TCP/IP Printing for Windows XP (continued)

D-Link
Building Networks for People DP-G310
AirPlus (G Wireless USB Print Server

Configuration [ECETNS TR

Wireless Interface

Connection Mode L% \nfrastructure
" Ad-Hoe
55ID ; |defalt {Manually Input or Select from List)

System Idefault vl
S SrvER |

i

Wireless Wireless Channel . |6 vl
Transmission Rate |Fu]lyAutornath vl
—
WEEENCHyplion © @ Disable C 64 bits © 128 hits
e WEP Key Format CEasc O HEX
User
Key 1 ;|
— Key 2 : |
SHNMP
Key 3 ] |
key 4 A

Encrypt Data Transmissions Using ; I Feyl 'I

Advanced Setting

Beacan Interval : IO— (ms)

Preamble o @ Long © Short

Authentication Type  © &' Open Systerm © Shared Key © Bath

9 9

Apply Cancel

Select your Connection Mode

Enter the SSID of the remote access point or wireless router you wish to
connect to.

If you would like to set WEP Encryption, select the encryption level and the
key here.

Click Apply



TCP/IP Printing for Windows XP (continued)

When you select TCP/IP Protocol at the Network window, the screen below
appears. (We recommend that you keep the default settings as shown.) If you need
to make changes, make sure to click Apply after you have made the changes. (You
may wish to make a note of the IP address.)

D-Link

Building Networks for People

DP-G310
AirPlus G Wireless USB Print Server

Configuration (R IR

TCPAP
IF Address

& Manually Assign

IP Address : |19Q.168.0.10
Subnet Mask - |255.255.255.0
System

Default Gateway - I0.0.0.0

|  automatically Assign

Wireless DNS Server Address 0,000
5 [0600

QRS

Network UPnP . @ Enable C Disable
MAC Rendezvous . U Enable © Disahble
Second HTTP Part A & Dj
{Iser Enable Disable
Part Mumber : IO
(For Remaote Weh Configuration and IPP Printing)
s Microsoft Network
Winrkgroup . IWORKGROUP
AppleTalk
AppleTalk Zone ; I*
UsB : Chooser Mame : DPG-301U
Printer Type : |L33&rWriter
PostSeript Level - |Level2 -
Font Group - | Standard 35 -

9 9

Apply Cancel




TCP/IP Printing for Windows XP (continued)

"% Printers and Faxes
Go to Start > Settings >

Printers and Faxes > File Edit View Faworites Tools  Help
Add a Printer

_.af" I ___s" ﬁ J’;- ) Search

Address | Printers and Faxes

#)

Printer Tasks

F,
{

=[] Add a printer
& Set up Faxing )
|Start the Add Printer Wizard,

Add Printer Wizard

Welcome to the Add Printer
@ Wizard

Thiz wizard helps wou install @ prinker or mak e printer
connections.

- If pou have a Plug and Flay printer that connects
\‘) through a USE port [or any ather hot plugoable
port. such &z |[EEE 1334, infrared. and 20 an), pou
do not need to use this wizard. Click Cancel to
cloze the wizard, and then plug the printer's cable
into your computer or poink the: prinker toward vour
computer's infrared part, and b the printer an,
Ywindows will automatically install the printer for you.

To continue, click Nest

Cancel

Click Next ¢ Back




TCP/IP Printing for Windows XP (continued)

Select Local Printer

Add Printer Wizard i

Local or Network Printer
The wizard needs to know which type of printer to set up.

Select the aption that describes the printer you want to use:

@ { acal printer attached to this computers

Deselect Automatically
detect and install my
Plug and Play printer.

Click Next

Select Create a new port. At

the pull-down menu, highlight
Standard TCP/IP Port.

> I~ Automatically detect and install my Plug and Plap printsr

& netwark printer, or a printer attached to anather computer

s To get up a netwark printer that iz not attached to a print server,
\1) uze the "Local printer” option.

< Back | I Next » I l Cancel

e——

Add Printer Wizard

Select a Printer Port
Computers communicate with printers through ports.

Select the poit you want your printer to use. If the port is not listed, you can create a
e part.

Ll

- Uze the following part: ILFT‘. [Recommended Frinter Part

Click Next

Click Next

@ Create a new pork
Type of part

Welcome to the Add Standard
TCP/IP Printer Port Wiz ard

(EE wnzard b add & poil foi 4 vetwl periei

Baio condrung be sue that

1 The device s kaned on
2 Ths restwsantk 2 comeacted and contigansd

To coetivnae chok Masr




TCP/IP Printing for Windows XP (continued)

x
) Add Port .

Type in the IP address Of For which device do you want to add a port?

the Print Server (l .e. Enler the Printer Name or IP addrass, and 2 port name for the desired device.

192.168._0.10). The_ Port b e [T

Name will automatically — e Jr—

be filled in.

< Back | Mext > I Cancel

Add Standard TCPAIP Printer Port Wizard

Additional Port Information Required
The device could not be identified

The detected device is of unknown lype. Be sure that:
1. The device is properly configured.
2. The address on the previous page it carrect,

Either canect the address and perform another search on the network by returning to the
previous wizaid page or select the device type if you are sure the address is conect.

Select Custom e
Then click Settings O Stenderd

P @ ouon

< Back " Hext > }[ Cancel ]

Configure Standard TCP/IP Port Monitor

Puoit Settings

Fort Mame: IP_192.168.0.10

Printer Name of IF Address: 152168010

Se|eCt L PR >P'”mm| ) Raw ) LPR

Faw Settings

Input the Port Name of LPR Setings

the port being used by =P
. []LPR Byte Counting Enabled

the printer.

[]5NMP Status Enabled

Click OK




TCP/IP Printing for Windows XP (continued)

Click Next

Click Finish

Highlight the printer, as shown.
If the desired printer is not on
the list, click Have Disk and
insert the printer driver disk that
came with your printer to install
the printer drivers.

Click Next

Add Standard TCPAIP Printer Port Wizard

Additional Port Inf ion Beguined

The device could not be identified

The detected device is of unknown type. Be sure that:
1. The device iz properly configured
2. The address on the previous page iz comect.

Either comect the address and perform another search on the network. by returning to the
previous wizard page or select the device type if pou are sure the address is comect.

Device Type
() Btandard

(%3 Custom

< Back i et ' Cancel

re Standard TCP/IP Port Monitor

Port Settings

Port Mame: 1F_192.168.0.10
Printer Hame or IP Address: 192.168.0.10
Pratocol
O Raw @ LPR

Flaw Settings

LFR Settings
Queus Mame: P5-116688-U1

[C]LPR Byte Counting Enabled

[] SMMP Status Enabled

fdd Printer Wizard

Install Printer S oftware
The manutacturer and model determine which printer software to use

L Select the manufacturer and model of your printer. If your printer came with an installstion
‘\.'é disk. click Hawe Disk. If your printer is not listed, consult your printer documentation far
compatible printer software.

Marufacturer # | Prinbers -~
Compaq S
g:"‘ta?’”d“m "o Epson Stylus COLOR 780 ESC/P 2
Digitl 55 Epsan Stylus COLOR 777 ESC/P 2
Een e e .
“5} This driver is digitally signed. [ \windows Update J l Have Digk. J
L is ;i

[fr—
< Back l Mest = !' Cancel




TCP/IP Printing for Windows XP (continued)

Name Your Printer
“fou must a3sign a name to this printer.

Type a name far this printer. Because some programs do not suppart printer and server

At thIS SCfeen, you Ca.n InpUt a gzrsr;?b%nmhinalinns of more than 31 characters, it iz best to keep the name az short as
name for the printer. Biite e

£

Clle Next < Back l' HNext > " Cancel

Print Test Page
To confirm that the printer is installed properly, you can print a test page

Do pou want ta print & test page?
= lres
= Mo

Clle NeXt ﬂ- Cancel

Add Printer Wizard

Completing the Add Printer
@ Wizard

You have successfully completed the Add Printer \Wizard
Y'ou specilied the following printer settings:

Mame: Epson Stylus COLOR 740 ESC/P 2
Share name:  <Mot Shared:

Port: IP_192168.0.10

b odet Epson Stylus COLOR 740 ESCAP 2
Default: Yes

Test page: Ma

To close this wizard, click Finish.

CIICk FI niSh < Back J Finish i Cancel




TCP/IP Printing for Windows 2000

Open the Web browser, and type in the IP Address of the DP-G310.
For example, type http://192.168.0.10 into the Location or Address field. Press
the Enter or (Return) Key.

Note:

The PC’s IP Address must be in the same subnet as the Print Server’s IP
Address for the two devices to communicate. (For example, if your Print
Server’s IP Address is 192.168.0.10, with a subnet mask of 255.255.255.0,
then your computer’s IP Address should be 192.168.0.x, where x is a value
between 1-254, excluding 10.)

File Edit Miew Favorites Tools  Help

¥ ¥ ;ﬂ \g ;: Py

Address | @] htbp:/192,168,0.10

DP-G310
A/rPlus G Wireless USB Print Server

L Configuationd _Tools 1 Help

Device Status

Server Name : DPG-301U

Model DP-G310

Firmware Version 1.00c (2003-12-29)
MAC Address © D0FFG0121B26

IP Address ¢ 192.168.0.10 (Manual)
Up Time 0 days, 00:00:08

System

Wireless Printer Status
use Printer Name DPG-301U

J—— Printer Speed Full Speed (12M bps)
Network Printer Status offline

Total Print Jobs 0
User Total Print Size 0 KBytes

ofl ¢

Printing Status dle
Name
MAC
P
Protocol
Spooling Size : 0 Bytes
Printing Size 0 Bytes

Ethernet Status

Link : Yes
Speed 100M bps
Duplex : Yes

Tx Packets D17
TxEnors 0
RxPackets D26
RxErrors o0




TCP/IP Printing for Windows 2000 (continued)

At the Configuration window, write down the Port Names for future reference.
You will need this information later in the configuration process.

D-Link
Building Networks for People DP-G310
AirPlus G Wireless USB Print Server

Configuration [NEZTTIN I

Systern Device
Server Name : IDPGBOIU
Location |

Admin Contact : |

— Password o Mew Password ;l****

Confirm Again . I****
I 2
Wireless
Port Setting
iz uss | PortName . [DPG-301U
Network
Description : |
— PJL Printer C|No -
User
— )
SHMP Apply Cancel




TCP/IP Printing for Windows 2000 (continued)

D-Link
Building Networks for People DP-G310
AirPlus G Wireless USB Print Server

-M Configuration -!!5!-

Wireless Interface

Connection Mode L% nfrastructure
" Ad-Hoc
55D © |detanlt {Manually Input or Select frarm List)

System Idﬁfault VI
Site Survey |

i

Wireless ‘Wireless Channel ] |6 vI
Transmission Rate IFquyAutomat'Lc vl
—
WWEF Encryption . @ Disable " 64 bits © 128 hits
[T WEP Key Format @ Aol O HEX
User
Key 1 |
[ — Key 2 A |
SHNMP
Key 3 : |
Key 4 A

Encrypt Data Transmissions Using ; | Keyl 'I

Advanced Setting

Beacon Interval : IU— {ms)

Preamble o @ Lang © Short

Authentication Type @ & Open System © Shared Key € Bath

9 9

Apply Cancel

Select your Connection Mode
Enter the SSID of the remote access point or wireless router to which you wish to
connect.

If you would like to set WEP Encryption, select the encryption level and the key here.
Click Apply.



TCP/IP Printing for Windows 2000 (continued)

D-Link s

AirPlus (G Wireless USB Print Server

Configuration (R IS

TCPAP
IF Address

& Manually Assign

IP Address . |19Q.168.0.10
Subnet Mask - |255.255.255.0
Default Gateway - I0.0.0.0

| © Autornatically Assign

DME Server Address 1|0'0'0'0
7. |0.0.0.0

System

Wireless

Network UPHP & Enable © Disable
MAC Rendezvous . U Enable © Disahle
Second HTTF Port © € Enable * Disahle

User
Port Number : |
(For Remote Weh Configuration and IPP Printing)

JOA

S Microsoft Network

Wiorkgroup . IWORKGROUP

AppleTalk

AppleTalk Zane : I*

UsB : Choaoser Mame : DPG-301U
Printer Type . |LaserWriter
PostScript Level : |Leve.12 vl
Font Group - | Standard 35 -

9 O

Apply Cancel

When you select TCP/IP Protocol at the Network window, the screen below
appears. (We recommend that you keep the default settings as shown.) If you need
to make changes, make sure to click Apply after you have made the changes. (You
may wish to make a note of the IP Address.)



TCP/IP Printing for Windows 2000 (continued)

Go to Start > Settings >
Printers

Double-click on the Add
Printer icon.

Click Next

B3 Printers O] x|

J File Edt “ew Go Favoites Help ‘

4-.-».@‘&% ‘ ?
Bk e lp Cut Copy Paste

J Address I Printers

[

Add Frinter

Printers

Add Printer

The add
Printer wizard
walks you
step-by-step
through
installing a
printer, Just
follow the
instructions
on each
sCreen.

Welcome to the Add Standard
TCP/IP Printer Port Wizard

“Y'ou uze thiz wizard to add a port for a network printer,
Before continuing be sure that:

1. The device is turned on.
2. The network iz connected and configured.

To continue, click Mext.

Cancel




TCP/IP Printing for Windows 2000 (continued)

| neal or Metwnork Printes
|5 me prer attached io o campule?

Select Local Printer

 New Printes Detection

Click Next

Select Create a new port at the
pull-down menu, highlight Standard
TCP/IP Port.

Click Next

44



TCP/IP Printing for Windows 2000 (continued)

Akl Standard TCP/IP Printer Port Wizard = x|

welcome ro the Add Srandard
TCPAIP Printer Port Wizard

Vo use ths wnzard lo add = potl fot 4 neteosd e

Babue cotinung be pue thar
1 The device 15 bared on
2 The restesonk s connected and conbigued

To cotinia, chok Maw

Click Next -

Type |n the IP address Of the PI’II’]'[ Add Standard TCP/IP Printer Port Wizard E|
Server in the Printer Name or IP T T —

Address field. The Port Name field
will automatically be filled in.

Enter the Printer Name or IP address, and a port name for the desired device.

—} Printer Mame or IP Address: 192168010

} Port Name: IP_192 168010

. ——
Click Next < Back [ Cancel

Add Standard TCP/IP Printer Port Wizard _

Additional Port Inf T —

The device could not be identified

The detected device is of unknown type. Be sue that:
1. The device is properly configured.
2. The address on the previous page is correct.

Either corect the address and perform another search on the network, by retuming to the
previous wizard page o select the device bpe if you are sure the address is comect.

Select “Custom” Device Type
i H ) Shandan
Then click on Settings. R

> =)

< Back ][ Mext > ]l Cancel




TCP/IP Printing for Windows 2000 (continued)

ipure Standard TCP/IP Port Monitor

Puoit Settings

Part Hame: IP_132.168.0.10

Printer Name of IF Address: 152168010

Select LPR

Input the port name of
the port being used by
the printer.

Click OK

Click Next

Click Finish

Pratocol
> © Raw @LPR

Faw Settings

LPR Seltings

> PS-116688-U1

[C]LPR Byte Counting Enabled

[]5NMP Status Enabled

Add Standard TCP/IP Printer Port

Additional Port Information Required
The device could not be identified

The delected device is of unknown lype. Be sure that
1. The devics is properly configured
2 The addiess on the previous page is corect

Either conect the address and perform another search on the network by retuming to the
previous wizard page or select the device type if you are sure the addiess is comect,

Dvias Tipe
) Standard

() Custom Setlings..

< Back [ Hext > Cancel
| ¢

Add Standard TCP/IP Printer Port Wizard

Completing the Add Standard
TCP/IP Printer Port Wizard

“ou have selected a port with the following characteristics.

SNMP: No

Pratacol: LPR. PS-116633-U1
Device: 182168010

Port Name:  IP_192.168.0.10
Adapter Type:

To complete this wizard, click Finish,

< Back l[ Finish ][ Cancel J




TCP/IP Printing for Windows 2000 (continued)

fidd Printer Wizard

Install Printer 5oftware
The manufacturer and model determine which printer software to use.

i Select the manufacturer and model of wour printer. If your prinker came with an installation

Highlight the printer, as shown.

|f the desired printer iS not on \ﬂ SE:;D Ca‘tlﬁjaHp:vnfe?.‘:nﬁi .,U o piinter is ot listed, consult your printer documentation for
the list, click Have Disk and
insert the printer driver disk that

. ) . Manufacturer # | Printers -
came with your printer to install Compag B {Eosor Stukis CULUR T40ESC/P 2
. . ch‘oagi;uduc‘s “of Epson Stylus COLOR 760 ESC/P 2
the printer drivers. Digial 3 Epson Stylus COLOR 777 ESC/P 2
Epson o "o Epson Stylus COLOR 800 ESC/P 2 g
=S ke R L L L
“# Thig driver iz digitally signed, [ ‘windows Update ] |_ Have Disk... J
i i ighing is i (f

C“Ck NeXt < Back w Mest » ' Cancel

Add Printer Wizard

Name Your Printer
You must assign a name to this printer,

At this screen, you can input a
A Type & name for this printer. Because some programs do nat support printer and server
name for the pr|nter name combinations of more than 31 characters, it is best to keep the name ag short as

possible.

FErinter name:

C“Ck NeXt [ < Back H HNext » "[ Cancel J




TCP/IP Printing for Windows 2000 (continued)

Select Do not share this printer.

Add Printer Wizard «

Printer Sharing

Vou can shate this parter wih cthet netwerk users v

Indicate whethes you want thes printer to be avadable to other users If you share this
printer, pou must piovide a share nama.

Click Next

Select Yes to print a test page.

Click Next

Click Finish

The printer is now ready for
printing with Windows 2000 on
your network.

® Dg ot share this printer
" Shae as

< Back Next > Cancel

I ———

Pririt T st Page
T2 caniem thar the purder n rstsled mopeily, you can pord 3 lesl page

Do poua et 1oy print 2 test page
* [fes
Mg

o () e |

Add Printer Wizard

Completing the Add Printer
Wizard

“Y'ou have successiully completed the Add Printer Wizard.
‘Y'ou specified the following printer settings:

Name: Epson Stylus COLOR 740 ESC/P 2

Share name:  <Mot Shared>

Part: IP_132168.0.10

Model: Epson Stylus COLOR 740 ESC/P 2
Diefault Yes

Testpage. Mo

To close this wizard, click Finish

Finish




TCP/IP Printing
for Windows 98SE/Me

Open the web browser, and type in the IP Address of the DP-G310.
For example, type http://192.168.0.10 into the Location or Address field. Press
the Enter or (Return) Key.

Note:

Your PC'’s IP Address must be in the same subnet as the Print Server’s IP
Address for the two devices to communicate. (For example, if your Print
Server’'s |IP Address is 192.168.0.10, with a subnet mask of 255.255.255.0,
then your computer’s IP Address should be 192.168.0.x, where X is a value
between 1-254, excluding 10.)

File Edit ‘Wiew Favorites Tools Help

-
v L’ﬂ Lg M|
Address | @) hitpif{192,168.0,10

DP-G310

AirPlus G Wireless USB Print Server

LW Corfigurationd _Tools_{ _Help_J

Device Status

Server Name DPG-301U

Model DP-6310

Firmware Version 1.00¢ (2003-12-29)
MAC Address 00FF 60121826
System IP Address 192.168.0.10 (Manual)
Up Time 0 days, 00:00:08

Wireless Printer Status
use Printer Name DPG-301U

—_— Printer Speed Full Speed (12M bps)
Network Printer Status offline

F— Total Print Jobs 0
User Total Print Size 0Kytes

QO €

Printing Status Idle
Name
MAC
P
Protocol
Spooling Size 0Bytes
Printing Size 0 Bytes

Ethernet Status

Link Yes
Speed 100M bps
Duplex Yes

Tx Packets 17
TxErrors 0
RxPackets 26
RxErrors 0




TCP/IP Printing for Windows 98SE/Me (continued)

At the Configuration window, write down the Port Name for future reference.
You will need this information later in the configuration process. The Port Name
shown here is only an example.

D-Link

Building Networks for People

DP-G310
A/rPlus (G Wireless USB Print Server

| Home MNNMPOSE  Tools 4 Help o

System Device

Sener Marme ] IDP(}SOIU

Location 2 |

Admin Contact : |

System
= — Password © Mew Password ;I****

Canfirm Again A his
Wireless
Port Setting
R [Bl=1=] § Port Mame - [DBG-30117
Network
Description : I
) — PuL Printer Mo -
User
— Q
SNMP Apply Cancel




TCP/IP Printing for Windows 98SE/Me(continued)

D-Link
Building Networks for People DP-G310
AirPlus G Wireless USB Print Server

Configuration [NECYT I TR

Wireless Interface

Connection Mode L% nfrastructure
© Ad-Hoe
581D : |dEf'°“-‘-lt (Manually Input or Select from List
—
System I‘i@ﬁ*“-’-lt 'I
St Survey |
Wireless Wireless Channel ] |6 vl
Transmission Rate  : |Fu]lyAut0math vl
—
EEE i
WEP Encryption @ pisable © 64 bits © 128 bits
EE— = WEP Key Format Do oasc)  HEY
User
Key 1 4 I
—— Key 2 A
SHMP
Key 3 s |
Key 4 ! |

Encrypt Data Transmissions Lsing ; I Key 1 'I

Advanced Setting

Beacon Interval : IO— (ms)

Prearmble © @ Long © Short

Authentication Type @ ' Cpen System © Shared Key © Bath

9 O

Apply Cancel

Select your Connection Mode.

Enter the SSID of the remote access point or wireless router to which you wish to
connect.

If you would like to set WEP Encryption, select the encryption level and the key
here.

Click Apply.



TCP/IP Printing for Windows 98SE/Me(continued)

When you select TCP/IP Protocol at the Network window, the screen below will
appear. (We recommend that you keep the default settings as shown.) If you need
to make changes, make sure to click Apply after you have made the changes. (You
may wish to make a note of the IP address.)

D-Link
Building Networks for People DP-G310
A/rPlus (G Wireless USB Print Server

Configuration [EZETINE T

TCPAP
IP Address

& Manually Assign

IP Address . IIQQ.ISS.O.IO
SubnetMagk . 2552552550
— |
System
Default Gateway - I0.0.0.0

|  Automnatically Assion

DMS Server Address © 1|0,0,0,0
3 I0.0.0.0

Network UPnP . @ Enable © Disable

Wireless

[

MAC Rendezvous : " Enahble € Disable
Second HTTP Port © 7 Enable * Disahle

Fort Mumber : IO

(For Remate Weh Configuration and IPP Printing)

User

SNMP

U

Microsoft Network

Warkgroup : IWORKGROUP

AppleTalk

AnpleTalk Zone ; I*

UsB : Chooser Mame : DPG-301U

Printer Type : |LaserWrita
PostScript Level : |Lexr812 vl

Font Group - |Standard 35

9 O

Apply Cancel




TCP/IP Printing for Windows 98SE/Me (continued)

Network EdEd

Configuration I Identificatiunl Access Eu:untrull

The following network, components are installed:

Go to Start > Settings > Client for Microsaft Networks j

Control Panel Micrazaft Family Logan

. Dr-Link &irFlug =treme G Dhw/L-GEBO
Double-click on Network Disklp Adapter

Realtek RTLE139 Family PCI Fast Ethermet NIC _ILI
1| | »

Eemowe | Fioperies |

Click Add

Primany Metwark, Logon:
Microsoft Family Logan j

Filz and Frint Sharing... |

Dezcription

OF. | Cancel |

Select Network Component Type |

LClick the type of network, component you want to ingtall

Clignt

Highlight Client 5] ﬁdpter — I

i Pratocal Cancel |
Click Add Service

&, client enables vour computer ko connect to ather
corpliters.




TCP/IP Printing for Windows 98SE/Me (continued)

Select Network Client E

i i Click the Metwork Client that pou want to inzstall, then click OF. [f pou have
At this WlndOV'V, an installation disk for this device, click Have Disk.
click Have Disk.

Manufacturers: Metwork Clients:

B Banyan DOS Avfindows 3.1 client

Have Dizk. .. |]
1. Insert the DP-G310

CD-ROM into your 0K | Cancel
CD-ROM drive. l

Select the letter

representing the

CD-ROM drive on Op=n

your computer from File name: Ealders: a4 0Ok,

K1 E4
the pull-down menu. | [ietinf g:Alpr
2 Cancel
P~y

2. Double-click on
the folder lpr.

Metwork...

3. Highlight Ipr.inf

4. Click OK Drives:
1 | Da j

Install From Dizk E3

Click OK to accept the Inzert the manufacturer's installation disk inta
location of the file. @ the drive selected, and then click OF.

Cancel

Copy manufacturer's files fron:

G:A\LFR j Browsze. |




TCP/IP Printing for Windows 98SE/Me (continued)

Select Metwork Client
E Click the Metwork Client that you want ta inztall, then click Ok, [f you have
—4 an installation dizk for this device, click Have Disk.

Models:

Have Disk... |
(]4 I Cancel |
Hetwork EE |

Configuration | Identificatinnl Access Ennlrnll

Click OK

You should now be
back to the Network
Properties Page.
Highlight LPR for
TCP/IP Printing.

The following network, components are installed:

B Client for Microzoft Mebwaorks -
l LPR for TCPAP Prirting

83 0-Link AirPlus #treme G DwL-GES0

J8 Dial-Up &dapter -
1| | v

EEmasyE Froperiies

Click Properties Primary Metwork Logon:
bicrozoft Family Logon j

File and Frint Sharing...

Diezcription

OF. Cancel




TCP/IP Printing for Windows 98SE/Me (continued)

LPR for TCP/IF Printing Properties
Parts | S ettings |
—Part List
Click Add Port
Acld Part... [Delete Part
ak I Cancel |
.
Type in the IP Address of
IP Address -
the DP-G310. Make sure IW

the Port Name is accu-
rate. (The Port Name at Port Name:
right is just an example.) [ps-116ses.Lit

Click OK |

LPR for TCP/IP Prnnting Properties %]

Farts | Settingsl

The Port name and IP et

Address will be displayed.
(The Port Name at right is
just an example.)

Acled Port... Celete Port

Click OK

Cancel

g




TCP/IP Printing for Windows 98SE/Me (continued)

Hetwork EEd |

Configuration | |dentification I Arccess Eu:untru:ull

The following netwark, components are installed:

Client for Microsoft Metwaorks

LPR for TCPAP Printing j

Microzoft Family Logon

O-Link AirPlus =treme G DwL-GER0
Dial-Up Adapter

-
4| | v

HEemove |

Froperties |

Prirnary Metwork, Logaon:

icrozoft Family Logon j

File: and Print Sharing... |

[rescription

Click OK

k. Cancel

Windows will ask for Bkl ie 1
arestart.

‘fou musk restart your computer before the new settings will take effect,

Do you wank ko restart your computer now?

Click Yes

Yes Mo




TCP/IP Printing for Windows 98SE/Me continued)

Once your computer has rebooted, click on

Eﬁ Add Printer
Start > Settings > Printers > Add Printer _>

Add Printer Wizard

This wizard will help you to install your printer quickly and
easily.

Ta begin installing your printer, click Next.

When the Add Printer Wizard
screen appears, click Next.

Select Network Printer.

|Add Printer Wizard

How is this printer attached to your computer?

Ifitis directly attached to your computer. click Local
Printer. If it is attached to anather computer, click Network
Printer

€ Local printer

' Network printer

Click Next

Add Printer Wizard
Type the network path of the queue name of your printer.

IF you don't know its name, click Browse to view available
netwark printers.

Type in the path if you know it,
or click Browse.

Network path or queue name:

Do you print from MS-D0S-based programs?
(" Yes
= No

< Back Next > Cancel




TCP/IP Printing for Windows 98SE/Me (continued)

At the next screen, browse for the printer
port. Highlight the port as shown. (The Port
Name in this window is just an example.)

Click OK

If the network path is not specified, type in
the IP Address of the DP-G310 and the Port
Name. (The Port Name shown at right is
just an example.)

Select Yes or No, to answer the question:
Do you print from MS-DOS based pro-
grams?

Click Next

Highlight the printer, as shown. If your desired
printer is not on the list, click Have Disk and
insert the printer driver disk that came with
your printer to install the printer drivers.

Click Next

Click Next

Browse for Printer HE

Select the network printer that you want to add.
Mote: Printers are usually attached to computers.

=28 Metwork Meighborhood
EM)_) Erttire Network,

SR % Pt S ervers - 1CP/F LAR

== 192 158.0.10

' [t i l Cancel |

——

Add Printer Wizard

Type the netwark path of the queue name of your printer.
IF you don't know s name, click Biowse ta view avalable
network prnters

Network path or queue name:

\AT52 166.0. 10%ps- 1166881

Blowse,

Do you piint from MS-DOS-based programs
—
=  Yes

& hlo

¢Back [| Nt > l Cancel |

Add Printer Wizard

s, Dok the manacturer ad modelof your pinte. I your vt cene wih an
[ instalalion disk, click Have Disk. If your printer s nat lsted, consult your printer
documentation for a orpatibls printer.

Manufacturers Printers:

Colorbae =] [Epson Sl Pro ESCP 2 =
Compag | [Epson Stis ProxL ESCiP 2

Dataproducts Epson Stylus Pra XL+ ESC/P 2

Dicarix Epson T-750

Digits!

LEPSOM Stlus COLOR 740

Frits |

<gack! Hext> ' |

Add Printer Wizard

‘ou can type a name for this printer, or you can use
the name supplied below. When pou are ready, click.
Finish ta install the printar and add it to the Printers

o folder

Brinter name:

“Your Windows-based programs will use this printer as the
default printer.

<Baok (| Fish |} cancel




TCP/IP Printing for Windows 98SE/Me (continued)

Select Yes to print
a test page.

Click Finish

Go to Start >
Settings > Printers

Check to see that your

printer is installed.

B3 Printers

Add Printer

The Add
Printer wizard
wallks you
step-by-step
through
installing a
printer. Just
follaw the
instructions
on =each
sCreen.

' Printers

2

Add Printer - EPSOM Stylus
COLOR 740

60



Unix/Linux Printing

Please refer to the PS Admin Manual on the CD included with your purchase for
information on setting up the Print Server in Unix/Linux.



Setting up Apple Talk or LPR
Printing in Mac OS X

Note: Mac OS printing with this print server is sup-
ported by PostScript printers only!

With Mac OSX you can use AppleTalk or LPR printers using IP protocols for printing
through Print Servers. Follow the instructions below for setting up the Print Server.
After attaching the Print Server to your network using the directions provided in the
Quick Installation Guide, change the IP address of your Macintosh to access the
Print Server’s web configuration.

Internet & Metwork

Openyour System
Preferences @
window and Click ; m
Network. Internet Network QuickTime Sharing
8 (23] Network =)
Location: | Automatic a
At the Configure show FRllER e

pull-down menu,
select Manually.

Manually
(&Ll BT  Using DHCP
Using BootP
sesmarmnmdMe Servers (Optional)
IP Address: 4.2.2.2
(Provided by DHCP Server)
Subnet Mask:
Router: Search Domains (Optional)
DHCP Client ID:
(Optional)

Example: apple.com, earthlink.net
Ethernet Address: 00:05:02:33:a3:84

@ Click the lock to prevent further changes. Af_'lﬂly Now



Setting up Apple Talk or LPR Printing
in Mac OS X (continued)

The default IP
address of the Print
Server is
192.168.0.10.
Manually change
your IP Address to
102.168.0.x, where
X is any number
between 1 and 254
(except 10 which is
the IP Address of
the Print Server.)
The IP Addresses
and Subnet Mask
shown here are
examples only.

Select the AppleTalk

tab in this window
and check Make
AppleTalk Active.

e 0 Network (=]
= a4 O
SthAII . Dlspla\rs Sound Neunrnrk Startup Disk
Location: = Automatic m
Show: PCl Ethernet Slot C1 [ia)

— . - N ]

; 2 = = g xies
Manually using !!HCP Router l

Configure + Using DHCP
Using BootP

_"m_—_dame Servers (Dptional)

IP Address: 192.168.10.7
{Provided by DHCP Server}

Subnet Mask: 255.255.255.0

Search Domains (Optional)

Router: 192.168.10.1

DHCP Client 1D:
(Optional)

Example: apple.com, earthlink.net
Ethernet Address: 00:50:ba:b0:00:05

a Apply N
\EJ Click the lock to prevent fu'*.ﬁ}m - % poly Mow

[S)

Location: | Automatic "?1

Show: | Built-in Ethernet

Network =

| TCP/IP

[ Make AppleTalk Active )

Computer Name: D link’s Computer
{Can be changed in Sharing Preferences)

AppleTalk Zone: e

Configure: = Automatically i

AppleTalk zones are unavailable until AppleTalk is on. To start AppleTalk, click Save.
Then choose a zone.

{ Apply Now

@ Click the lock to prevent further changes.



Setting up Apple Talk or LPR Printing
iIn Mac OS X (continued)

To print, open a document
and select File > Print
from the menu.

Select Edit Printer
List from the Printer
dialog box.

Click Add Printer.

TextEdit Edit Format Window Help
New N -
Qpen... g0 [pritled
Open Recent >
Close ®W
Save 385
Save As... £ 8S
Save All

Revert to Saved

Page Setup... <%P

Printer: ] v No Printer Selected '

EEWLBSGLNER ( Edit Printer List )
rCnpies & Pages F'i!
Copies: E # Collated
Pages: @ All
O From: 1 ta: |1
) (Preview ) (Cancel ) Print
e0ce Printer List

“® FName & Kind

Status

‘ Delete

(Crearimer )

64



Setting up Apple Talk or LPR Printing
in Mac OS X (continued)

Select the printing

protocol preferred, v App!eTalk . E
AppleTalk or LPR LFS'R Printers using IP :
Printers using IP. e ¥
In this example, F"Name | Directory Services _
AppleTalk has been B ps - 116683-UL T
selected.
Printer Model: Auto Select... ﬂ
 Cancel * 'Fm

AppleTalk protocol:

- 80e Printer List
After selecting - = Kind Status
AppleTalk the Port PS - 116688-U1 Laserwriter

Name of the Print
Server will be dis-
played. The Port
Name shown here is 9
an example only.

Click on the Port to
which the PostScript
printer is connected.

{ Delete * [ Add Printer_. |

Then select the printer model from the dialog box displayed here.
Click Add Printer and the Printer Port configuration is complete.
Select the Printer Port just configured in the Print window.

Click Print to print your document.




Setting up Apple Talk or LPR Printing
in Mac OS X (continued)

LPR Printers using IP
protocol: LPR Printers using IP a

When you select LPR —————
Printers using IP Proto-
col, this window will ap-

LPR Printer's Address: 192.168.0.10
Internet address or DMS name

pear.
[ Use Default Queue on Server
Type the IP Address of the Queue Name: | PS-116688 - UL
Print Server into the LPR
Printer’s Address field. Printer Model: | Generic D
"_ Cancel .‘ m

In the Queue Name field, type in the Port Name of the PostScript printer that is
connected to the Print Server. The Port Name illustrated here is only an example.
Select the printer model from the dialog box.

In the Queue Name field, type in the Port Name of the PostScript printer that is
connected to the Print Server. The Port Name illustrated here is only an example.
Select the printer model from the dialog box.

Click Add and the process is complete.

Close all Print Center windows, select the Printer Port that was just selected.

Click Print to print the document.Click Add and the process is complete.



Setting up Apple Talk Printing
iIn Mac OS 9

Note: Mac OS printing with this print server sup-
ports PostScript printers only!

The AppleTalk network protocol is used with computers using the MacOS operating
system. It can be used for network communications over standard Ethernet or Fast
Ethernet using the EtherTalk transport, or over a proprietary low-speed LocalTalk
transport.

Your Print Server can be used for network printing to PostScript printers. You can
print from any MacOS computer connected to your Ethernet network, either directly
using an EtherTalk connection, or indirectly through a LocalTalk-to-EtherTalk router.

NOTE: The Chooser name of a printer connected to one of the Print Server’s ports
is the same as its Port Name. If you are using AppleTalk printing, you will need to
make sure that every Port Name is unigue among all of the network printers in your
AppleTalk zone. The Port Names shown in this manual are examples only.

Setting up the Print Server for AppleTalk Printing

To set up your Print Server so that it can be used for AppleTalk printing:

m Make sure the AppleTalk protocol is enabled in your Macintosh.

m Change the IP address on one of the computers on your network to
192.168.0.x, where x is any humber between 11-254.

m Type 192.168.0.10 into the address field of your Web browser. 192.168.0.10
is the default IP Address of the DP-G310.

m Select the Network tab and scroll to the bottom to the AppleTalk protocol
section.

m If your AppleTalk network is divided into AppleTalk zones, you will have to
specify which zone the Print Server should be in. You should locate the Print
Server in the same zone as most of the users who will be using it. If your
network is not divided into zones, the AppleTalk Zone field should contain a
single asterisk “*”.



Printing from Mac OS Client Workstations

The exact procedure for selecting a PostScript printer connected to your Print
Server may vary slightly, depending on what printer driver version you are using.
The procedure described below assumes you are using the LaserWriter 8.

To choose a printer connected to your Print Server as your Mac OS
workstation’s default printer,

Open the Chooser by selecting Chooser from the Apple menu.

Select the LaserWriter 8 icon on the left. Make sure that AppleTalk is set
to Active.

A list of all networked PostScript printers will be displayed:

=————————(hnser=—————"——-H

Select a PostScript Printer:

@ PS-116688-U1

re Color 2% Fro

00/LS | Laserwriter

%

Double-click the name of
the Printer Port you wish
to use. The Printer Ports
shown are examples only. | |=er

2Sh,

>
o
o

o

&

]

ter

E

Frewiew™

@ Active
) Inactive 7.6.2

AppleTalk




Printing from Mac OS Client Workstations

(continued)

If you have not previously
set this printer as the
default, your computer
will prompt you for a
PostScript Printer
Description file. Choose
Select PPD.

Select the appropriate
printer description file for
your printer.

Click Open.

(If your printer is not listed,
click Generic to use a
generic printer
description.)

Current Printer Description File (PPD) Selected:
= “Generic®
Auto Setup | ' Select PPD... I'
[ Printer Info ] [ Configure ]
Open
@ Printer Descriptions i] E@
Name | Date Moditied |2
T3 HF LagerJet 4L 547701 =
EJP HF Laser.Jet 4MP 547701
EJ HP LaserJet 4MP ¢ 300 dpi) 547401
8 HP LaserJet 451 (300 dpi) 547701
0 THP LaserJet 45i v2011.110 547401 | |
3 HP LaserJat 4 543/01 %
Use the Generic PostScript™ Printer Description file:
(eancet ([ _oper

If you wish to access this setting in the future, you can use the Setup button in the

Chooser window.

The selected printer will become your computer’s default printer. You may need to
choose Page Setup in any applications you have open.




Networking Basics

Using the Network Setup Wizard in Windows XP

In this section you will learn how to establish a network at home or work, using
Microsoft Windows XP.

Note: Please refer to websites such as http://www.homenethelp.com
and http://mwww.microsoft.com/windows2000 for information about networking
computers using Windows 2000, ME or 98SE.

Go to Start>Control Panel>Network Connections

Metwork Setup Wizard

Welcome to the Network Setup
% Wizard

Thiz wizard will help pou zet up this computer ta min on waur
network, “With a netwark you carn;

+ Share an Internet connection

+ Set up Internet Connection Firewall
+ Share filez and folderz

+ Share a printer

To continue, click Mest.

Mext = ﬂ[ Cancel

When this screen appears, click Next.



Networking Basics (continued)

Please follow all
the instructions in
this window:

In this window,
select the

best description of
your computer.

If your computer
connects to the
Internet through a
gateway/router,
select the second
option as shown.

Click Next

Metwork Setup Wizard

Before you continue. .. %

Befare pou continue, review the Thecklist for creating a netwark,

Then, complete the following steps:

+ |nstall the network. cards, modems, and cables.

+ Turn on all computers, printers, and extemnal modems.
+ Connect to the Intemet,

‘wihen pou click Mest, the wizard will search for & shared Internet connection on your network.,

< Back Il Hest » ][ Cancel
|

Network Setup Wizard
Select a connection method. %

Select the staterment that best describes this computer:

() Thiz computer connects directly to the Intemet. The other computers on my network, connect
to the Intermet through this computer.

Wiew an example.

(=) This computer connects ta the Intemet through another computer on my netwark, or through
a residential gateway.

Wiew an example.

i

Learn more about horme or small office network, configurations.

(r—
< Back I’ Hest » " Cancel




Networking Basics (continued)

Enter a Computer
description and a
Computer name
(optional.)

Network Setup Wizard
Give this computer a description and name. %

' LComputer description: | Mary's Compuier |

Examples; Family Foom Computer or Monica's Computer

' Campuiter narme: Office N _]

Click Next

Enter a Workgroup

Network Setup Wizard
name. All computers

on your network
should have the
same Workgroup
name.

Examples: FAMILY or MONICA '

The cumrent computer hame iz Office

Learn more about computer names and descriptions.

< Back Mest = I Cancel

Mame your network. .%

M ame your network, by specifying a workgroup name below. All computers on your network
shauld have the same warkgroup name.

Click Next

. whorkgroup name: Accounting |
Examples: HOME or OFFICE

[ < Back I'][ Mest » I][ Cancel ]




Networking Basics (continued)

Please wai whie
the Network Ready to apply network settings.__.
Setup Wizard

applies the
changes.

The wizard will apply the following zettings. Thiz process may take a few minutes to complete
and cannot be interupted,

Deltings: =
| Metwork settings: |

Computer description: Mary's Computer

Computer name: Office
‘workgroup name; Accounting
The Shared Documents folder and any printers connected to this computer have been
shared.
To apply theze zettings, click Mext.
When the changes
are Complete’ [ < Back ” Mext » I [ Cancel

click Next.

Please wait while
the Network Please wait... %
Setup Wizard

configures the

ComPUter' Please wait while the wizard configures this computer for home ar zmall office networking. This
ThlS may take a process may take a few minutes.
few minutes.

L LN




Networking Basics (continued)

In this window, select
the best option. In this
example, Create a
Network Setup Disk
has been selected.
You will run this disk on
each of the computers
on your network.

Click Next

Insert a disk into the
Floppy Disk Drive, in
this case drive A.

Format the disk if you
wish, and click Next.

Metwork Setup Wizard
You're almost done... .[%

= “ou need to run the Metwork Setup ‘Wizard once on each of the computers on pour
\ll) retwork. To mn the wizard on computers that are not running Windows ¥P, you can uze
the Windows =P CD or a Metwork Setup Disk.

wihat do you want to do’?

() Usze the Metwork Setup Disk | aheady have
() Uge my Windaws <P CD

() Just fimish the wizard; | don't need to run the wizard on other computers

Network Setup Wizard
Insert the disk you want to use. .

Ingert a dizk the into the following digk drive, and then click Mest.

3% Floppy [4:]

If pou want to format the disk, click Format Disk.

< Back ]i Mest > ﬂ




Networking Basics (continued)

Please wait while the Network Setup Wizard copies the files.

Copying... E

S99 L/

Please wait while the wizard copies files. ..

[ ) Cancel |

Please read the information under Here's how in the screen below. After you
complete the Network Setup Wizard you will use the Network Setup Disk to run
the Network Setup Wizard once on each of the computers on your network. To
continue, click Next.

Network Setup Wizard

To run the wizard with the Network Setup Disk. .. %
e

* . Complete the wizard and restart thiz computer. Then, uze the Mebwork Setup Dizk to run
1 the Metwork, Setup Wizard once on each of the other computers o pour networl:,

Here's how:

1. Inzert the Metwaork, Setup Dizk into the nest computer you want to network,
2. Open My Computer and then open the Nebwark Setup Disk.
3. Double-click "netzetup.''

¢ Back li_ﬂe:-:w J




Networking Basics (continued)

Metwork Setup Wizard

Completing the Network Setup
Wizard

You have successiully et up thiz computer for home or zmall
office nebworking.

Far help with hare ar gmall affice networking, see the
fallowing topics in Help and Support Center;

+ zing the Shared Documents folder
+ Sharnng hles and folders

To zee other computers on your nebwark, click Start, and then
click My Metwark Places.

To cloge thiz wizard, click Finizh.

<Back || Finish |

The new settings will take effect when you restart the computer. Click Yes to re-
start the computer.

System Settings Change x

P You musk restart wour computer before the new settings will take effect,

o

Do wou wank bo restark your compuker now?

You have completed configuring this computer. Next, you will need to run the Net-
work Setup Disk on all the other computers on your network. After running the

Network Setup Disk on all your computers, your new wireless network will be
ready to use.



Networking Basics (continued)
How to assign a Name to your computer

To name your computer, please follow these directions in Windows XP:

m Click Start (in the lower left corner of the screen)

= Right-click My Computer
m Select Properties

n Zommand Prompk

i
@ Windows Movie Maker
“ M3l Explorer

® Windows Media Plaver
t@ Tour Windows XP

All Programs b

m Select the Computer
Name tab in the System B
Properties window. System Re

General

System Properties

= You may enter a Cormputer description:

Computer Description
(optional).

Full computer name:

workgroup:

= To rename the computer

w—— R
Open
g ™M Explore

Search...

Manage
B«

Map Metwork, Drive. ..
;"_# Pr Disconnect Metwork Drive. ..

Show on Desktop

@. He  Rename

fic Li_pciates Remate
Hardware | Advanced

windows uzes the following infomation to identify your computer
an the nebwork,

For example: "'Kitchen Computer” or "Many's
Cormputer''.

Office
Accounting

To uze the Mebwork |dentification ‘wizard to join a Matwark D
domain and create a local user account, click Metwaork =
1D,

and JOIn a domaln’ Click Ta rename this computer of join a domain, click Change.

Change.




Networking Basics (continued)
How to assign a Name to your Computer

= In this window, enter the
Computer name.

Select Workgroup and
enter the name of the
Workgroup.

All computers on your
network must have the same
Workgroup name.

s Click OK

How to find your IP Address

Computer Hame Changes

You can change the name and the membership of thiz
computer. Changes may affect access to netwark resources.

LComputer hame:
| Office :

Full computer name;

Office

Member of
() Domair:
|
@%mkgmup_:
==
in Windows XP

The computers connected to your network must be in the same IP address
range. To verify the IP address, please do the following:

= Right-click on the
Local Area Con-
nection icon in
the task bar.

Disable

Repair

m Click Status

YWiew dvailable \Wireless Metwarks

Open Metwork Connections




Networking Basics (continued)
How to find your IP Address in Windows XP

This window will appear. Wireless Network Connection 7 Status |E|E|
- Click the Internet Protocol [TCPAIF)
Support tab Address Type: Agsigned by DHCP
[ IP &ddress: 192.168.0.114 ]
Subnet Mask: 256.256.256.0
Default Gateway: 192.168.0.1

Details...

™ Click Close

l LCloze |

Assigning a Static IP Address in Windows XP/2000

Note: DHCP-capable routers will automatically assign IP addresses to the com-
puters on the network, using DHCP (Dynamic Host Configuration Protocol)
technology. If you are using a DHCP-capable router you will not need to assign
static IP addresses.

If you are not using a DHCP capable router, or you need to assign a static IP
address, please follow these instructions:

. ' = Zonkrol Panel
@ Tour Windows XP
u Go to Start Hﬁ Printers and Faxes
4| Files and Settings Transfer
Wizard
@) Help and Support:
Paink ;
. y Search
= Double-click s
Control Panel AR Piarams D 77 fun...

.| Log CFf rﬁ: Turn OFf Computer




Networking Basics (continued)
Assigning a Static IP Address in Windows XP/2000

B Double-click
Network
Connections

= Right-click Local Area
Connections

= Double-click
Properties

80

¥ Control Panel

File  Edit WView Favorites  Tools  Help

Q Back \‘) lt j:) Search u“ Falders

Address [} Conitral Panel

M Accessibility Options
S Add Hardware

Control Panel A '
‘L) add or Remove Programs
@ witch tn Category View “d Administrative Taols

See Also

S Windows Update
g) Help and Support

&= Game Controllers
’Internet Dptions

v Phione and Modem Options
ower Options

“aPrinters and Faxes

9 Regional and Language Options

(= Scanners and Cameras

A5cheduled Tasks

) Sounds and Audio Devices

& Taskbar and Start Menu
gd User Accounts

Flle Edt View Favorkes Took Advanced Help
A ™ 2
Qe = ) (T JDsewch [ roders | [-
Address | @ Metwark Connections
A hame
Network Tasks - LAN or High-Speed Internet
[&] Creste anew
cannection Disable
£ Set up a home or smal Status
office network Hopnt
& Disable this netwark
device Bridge Connections
&, Repai this connection
Create Shorteut
W) Rename this connection g
&) View status of this Hensine
connection
Change settings of this
connection
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Networking Basics (continued)
Assigning a Static IP Address in Windows XP/2000

m  Click Internet Protocol
(TCP/IP)

m  Click Properties

m Select Use the
following IP address in
the Internet Protocol
(TCP/IP)Properties
window.

= Inputyour IP address and
subnet mask. (The IP
addresses on your network
must be within the same
range. For example, if one
computer has an IP
address of 192.168.0.2, the
other computers should
have IP addresses that are
sequential, like 192.168.0.3
and 192.168.0.4. The
subnet mask must be the
same for all the computers
on the network.)

= Input your DNS server
addresses. (Note: If you
are entering a DNS server,
you must enter the IP
address of the Default
Gateway.)

The DNS server information will be supplied

by your ISP (Internet Service Provider.)
= Click OK

3

-4 Local Area Connection 7 Properties

General | Advanced

Connect using:

| B8  D-Link DWL-AB50

This connection uzes the following iterms:

vl 5 Client for Microsoft Networks

i Coae]
Description

Transmission Contral Protocol/Intemet Protocol. The default
wide area network, protocol that provides communication
across diverse interconnected networks.

[] Show icon in natification area when connected

Cancel ]

Internet Protocol (TCP/IP) Properties

General

You can get IP settings assigned autornatically if your network, suppaorts
thiz capability. Othenwize, you need ta azk your netwark. administrator for
the apprapriate IP settings.

() Obtain an IP address automatically

{#) Use the following IF address:

IP address: 192 .168. 0 . 52
Subnet mask: P a o' R
Default gateway: Toe. o8, 0o

() Use the following DS server addresses:
Prefemed DNS server . e, b,

Altemate DNS server:

(T |

Cancel ]




Technical Specifications

Printer Connection
Printer Port: USB 2.0

Bidirectional Communication: Hewlett-Packard PJL (Printer Job Language) standard
for bidirectional communication.

Network Connection

Network Standards: IEEE 802.3 10Base-T Ethernet, IEEE 802.11g Wireless Standard
Network Data Transfer Rate: 10/100 Mbps (megabits per second), up to 54Mbps
Network Connector: CAT5 cable

Network Protocols

Ethernet Frame Types: 802.2, 802.3, Ethernet Il, SNAP (auto-switching)

Transport Protocols: TCP/IP, NetBEUI, AppleTalk/EtherTalk, LPR,SMB

TCP/IP Protocols Supported: BOOTP, SNMP, Telnet, TFTP, FTP, LPD, RARP, DHCP, IPP

Management and Diagnostics
Standard: SNMP

MIBs: MIB-II (RFC 1213)

Diagnostic LED Indicators: Power, LAN, USB, WLAN

Environmental and Physical

Power Supply: External power supply providing 5V, 2.5ADC
Dimensions: 3.54"x3.19"x 1.57" (90mm x 81mm x 40mm)
Weight: approx. 5.19 oz. (1479)

Operating Temperature: 32t0122°F (0 to 50°C)

Storage Temperature: -13to 131°F (-25 to 55°C)
Humidity: 5% to 95% non-condensing

Emissions: FCC Class B, CE Class B, VCCI Class B



Technical Support

You can find software updates and user documentation on the D-Link website.

D-Link provides free technical support for customers within the United States and within
Canada for the duration of the warranty period on this product.

U.S. and Canadian customers can contact D-Link technical support through our website,
or by phone.

Tech Support for customers within the United States:

D-Link Technical Support over the Telephone:
(877)453-5465
24 hours a day, seven days a week.

D-Link Technical Support over the Internet:
http://support.dlink.com
email:support@dlink.com

Tech Support for customers within Canada:

D-Link Technical Support over the Telephone:
(800) 361-5265
Monday to Friday 8:30am to 9:00pm EST

D-Link Technical Support over the Internet:
http://support.dlink.ca
email:support@dlink.ca

When contacting technical support, please provide the following information:
* Serial number of the unit
* Model number or product name

« Software type and version number




Warranty and Registration

Subject to the terms and conditions set forth herein, D-Link Systems, Inc. (“D-Link”) provides this Limited
warranty for its product only to the person or entity that originally purchased the product from:

B D-Link or its authorized reseller or distributor and

B Products purchased and delivered within the fifty states of the United States, the District of
Columbia, U.S. Possessions or Protectorates, U.S. Military Installations, addresses with an APO or
FPO.

Limited Warranty: D-Link warrants that the hardware portion of the D-Link products described below will
be free from material defects in workmanship and materials from the date of original retail purchase of the
product, for the period set forth below applicable to the product type (“Warranty Period”), except as otherwise
stated herein.

1-Year Limited Warranty for the Product(s) is defined as follows:

M Hardware (excluding power supplies and fans)One (1) Year
B Power Supplies and Fans One (1) Year
M Spare parts and spare kits Ninety (90) days

D-Link’s sole obligation shall be to repair or replace the defective Hardware during the Warranty Period at no
charge to the original owner or to refund at D-Link’s sole discretion. Such repair or replacement will be
rendered by D-Link at an Authorized D-Link Service Office. The replacement Hardware need not be new or
have an identical make, model or part. D-Link may in its sole discretion replace the defective Hardware (or any
part thereof) with any reconditioned product that D-Link reasonably determines is substantially equivalent (or
superior) in all material respects to the defective Hardware. Repaired or replacement Hardware will be
warranted for the remainder of the original Warranty Period from the date of original retail purchase. If a
material defect is incapable of correction, or if D-Link determines in its sole discretion that it is not practical to
repair or replace the defective Hardware, the price paid by the original purchaser for the defective Hardware
will be refunded by D-Link upon return to D-Link of the defective Hardware. All Hardware (or part thereof) that
is replaced by D-Link, or for which the purchase price is refunded, shall become the property of D-Link upon
replacement or refund.

Limited Software Warranty: D-Link warrants that the software portion of the product (“Software”) will
substantially conform to D-Link’s then current functional specifications for the Software, as set forth in the
applicable documentation, from the date of original retail purchase of the Software for a period of ninety (90)
days (“Warranty Period”), provided that the Software is properly installed on approved hardware and
operated as contemplated in its documentation. D-Link further warrants that, during the Warranty Period, the
magnetic media on which D-Link delivers the Software will be free of physical defects. D-Link’s sole obligation
shall be to replace the non-conforming Software (or defective media) with software that substantially
conforms to D-Link’s functional specifications for the Software or to refund at D-Link’s sole discretion. Except
as otherwise agreed by D-Link in writing, the replacement Software is provided only to the original licensee,
and is subject to the terms and conditions of the license granted by D-Link for the Software. Software will be
warranted for the remainder of the original Warranty Period from the date or original retail purchase. If a
material non-conformance is incapable of correction, or if D-Link determines in its sole discretion that it is not
practical to replace the non-conforming Software, the price paid by the original licensee for the non-
conforming Software will be refunded by D-Link; provided that the non-conforming Software (and all copies
thereof) is first returned to D-Link. The license granted respecting any Software for which a refund is given
automatically terminates.

Non-Applicability of Warranty: The Limited Warranty provided hereunder for hardware and software of
D-Link’s products will not be applied to and does not cover any refurbished product and any product
purchased through the inventory clearance or liquidation sale or other sales in which D-Link, the sellers, or the
liquidators expressly disclaim their warranty obligation pertaining to the product and in that case, the product
is being sold “As-Is” without any warranty whatsoever including, without limitation, the Limited Warranty as
described herein, notwithstanding anything stated herein to the contrary.

Submitting A Claim: The customer shall return the product to the original purchase point based on its return
policy. In case the return policy period has expired and the product is within warranty, the customer shall
submit a claim to D-Link as outlined below:

The customer must submit with the product as part of the claim a written description of the
Hardware defect or Software nonconformance in sufficient detail to allow D-Link to confirm the
same.



B The original product owner must obtain a Return Material Authorization (‘RMA”) number from the
Authorized D-Link Service Office and, if requested, provide written proof of purchase of the
product (such as a copy of the dated purchase invoice for the product) before the warranty service
Is provided.

B After an RMA number is issued, the defective product must be packaged securely in the original or
other suitable shipping package to ensure that it will not be damaged in transit, and the RMA number
must be prominently marked on the outside of the package. Do not include any manuals or
accessories in the shipping package. D-Link will only replace the defective portion of the Product
and will not ship back any accessories.

M The customer is responsible for all in-bound shipping charges to D-Link. No Cash on Delivery
(“COD") is allowed. Products sent COD will either be rejected by D-Link or become the property of
D-Link. Products shall be fully insured by the customer and shipped to D-Link Systems, Inc.,
17595 Mt. Herrmann, Fountain Valley, CA 92708-4160. D-Link will not be held responsible for
any packages that are lost in transit to D-Link. The repaired or replaced packages will be shipped
to the customer via UPS Ground or any common carrier selected by D-Link, with shipping charges
prepaid. Expedited shipping is available if shipping charges are prepaid by the customer and upon
request.

D-Link may reject or return any product that is not packaged and shipped in strict compliance with the foregoing
requirements, or for which an RMA number is not visible from the outside of the package. The product owner
agrees to pay D-Link’s reasonable handling and return shipping charges for any product that is not packaged
and shipped in accordance with the foregoing requirements, or that is determined by D-Link not to be defective
or non-conforming.

What Is Not Covered: This limited warranty provided by D-Link does not cover: Products, if in D-Link’s
judgment, have been subjected to abuse, accident, alteration, modification, tampering, neghgence misuse,
faulty installation, lack of reasonable care, repair or service in any way that is not contemplated in the
documentation for the product, or if the model or serial number has been altered, tampered with, defaced or
removed; Initial installation, installation and removal of the product for repair, and shipping costs; Operational
adjustments covered in the operating manual for the product, and normal maintenance; Damage that occurs in
shipment, due to act of God, failures due to power surge, and cosmetic damage; Any hardware, software,
firmware or other products or services provided by anyone other than D-Link; Products that have been
purchased from inventory clearance or liquidation sales or other sales in which D-Link, the sellers, or the
liquidators expressly disclaim their warranty obligation pertaining to the product. Repair by anyone other than
D-Link or an Authorized D-Link Service Office will void this Warranty.

Disclaimer of Other Warranties: EXCEPT FOR THE LIMITED WARRANTY SPECIFIED HEREIN, THE
PRODUCT IS PROVIDED “AS-IS” WITHOUT ANY WARRANTY OF ANY KIND WHATSOEVER INCLUDING,
WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY, FITNESS FORAPARTICULAR PURPOSE
AND NON-INFRINGEMENT. IFANY IMPLIED WARRANTY CANNOT BE DISCLAIMED INANY TERRITORY WHERE
APRODUCT IS SOLD, THE DURATION OF SUCH IMPLIED WARRANTY SHALL BE LIMITED TO NINETY (90)
DAYS. EXCEPTAS EXPRESSLY COVERED UNDER THE LIMITED WARRANTY PROVIDED HEREIN, THE ENTIRE
RISKAS TO THE QUALITY, SELECTIONAND PERFORMANCE OF THE PRODUCT ISWITH THE PURCHASER OF
THEPRODUCT.

Limitation of Liability: TO THE MAXIMUM EXTENT PERMITTED BY LAW, D-LINK IS NOT LIABLE UNDER
ANY CONTRACT, NEGLIGENCE, STRICT LIABILITY OR OTHER LEGAL OR EQUITABLE THEORY FORANY
LOSS OF USE OF THE PRODUCT, INCONVENIENCE OR DAMAGES OF ANY CHARACTER, WHETHER DIRECT,
SPECIAL, INCIDENTAL OR CONSEQUENTIAL (INCLUDING, BUT NOT LIMITED TO, DAMAGES FOR LOSS OF
GOODWILL, LOSS OF REVENUE OR PROFIT, WORK STOPPAGE, COMPUTER FAILURE OR MALFUNCTION,
FAILURE OF OTHER EQUIPMENT OR COMPUTER PROGRAMS TO WHICH D-LINK'S PRODUCT IS CONNECTED
WITH, LOSS OF INFORMATION OR DATACONTAINED IN, STORED ON, OR INTEGRATED WITHANY PRODUCT
RETURNED TO D-LINK FOR WARRANTY SERVICE) RESULTING FROM THE USE OF THE PRODUCT, RELATING
TOWARRANTY SERVICE, ORARISING OUT OF ANY BREACH OF THIS LIMITED WARRANTY, EVEN IF D-LINK
HAS BEENADVISED OF THE POSSIBILITY OF SUCH DAMAGES. THE SOLE REMEDY FORABREACH OF THE
FOREGOING LIMITED WARRANTY IS REPAIR, REPLACEMENT OR REFUND OF THE DEFECTIVE OR NON-
CONFORMING PRODUCT. THE MAXIMUM LIABILITY OF D-LINK UNDER THIS WARRANTY IS LIMITED TO THE
PURCHASE PRICE OF THE PRODUCT COVERED BY THE WARRANTY. THE FOREGOING EXPRESS WRITTEN
WARRANTIES AND REMEDIES ARE EXCLUSIVE AND ARE IN LIEU OF ANY OTHER WARRANTIES OR
REMEDIES, EXPRESS, IMPLIED OR STATUTORY.



Governing Law: This Limited Warranty shall be governed by the laws of the State of California. Some states
do not allow exclusion or limitation of incidental or consequential damages, or limitations on how long an implied
warranty lasts, so the foregoing limitations and exclusions may not apply. This limited warranty provides
specific legal rights and the product owner may also have other rights which vary from state to state.

Trademarks: D-Link is a registered trademark of D-Link Systems, Inc. Other trademarks or registered
trademarks are the property of their respective manufacturers or owners.

Copyright Statement: No part of this publication or documentation accompanying this Product may be
reproduced in any form or by any means or used to make any derivative such as translation, transformation,
or adaptation without permission from D-Link Corporation/D-Link Systems, Inc., as stipulated by the United
States Copyright Act of 1976. Contents are subject to change without prior notice. Copyright® 2002 by D-Link
Corporation/D-Link Systems, Inc. All rights reserved.

CE Mark Warning: This is a Class B product. In a domestic environment, this product may cause radio
interference, in which case the user may be required to take adequate measures.

FCC Statement: This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communication. However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

Reorient or relocate the receiving antenna.

Increase the separation between the equipment and receiver.

Connect the equipment into an outlet on a circuit different from that to which
the receiver is connected.

Consult the dealer or an experienced radio/TV technician for help.

FCC Caution: Any changes or modifications not expressly approved by the party responsible for compliance
could void the user’s authority to operate this equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
(2)This device may not cause harmful interference, and (2) this device must accept any interference received,
including interference that may cause undesired operation.

IMPORTANT NOTE:
FCC Radiation Exposure Statement:

This equipment complies with FCC radiation exposure limits set forth for an uncontrolled environment. This
equipment should be installed and operated with a minimum distance of about 8 inches (20cm) between the
radiator and your body.

This transmitter must not be co-located or operated in conjunction with any other antenna or transmiter.

Register your D-Link product online at http://support.dlink.com/register/

(02/12/04)



Appendix:
DP-G310 Printer Compatibility List For Windows

The Canon Printer The Lexmark Printer
Canon BJC-55, 85 Lexmark Z13
Canon S100SP Lexmark Z25
Canon S200SP Lexmark Z33
Canon S300 Lexmark Z35
Canon S330 Lexmark Z43
Canon S400SP Lexmark Z45
Canon S450 Lexmark Z53
Canon S520
Canon S600
Canon S750
Canon S4500 The HP Printer
Canon S6300 HP DeskJet 640C, 656C
Canon S9000 HP DeskJet 845C

HP DeskJet 920C
The Epson Printer :E ggzgg: gggg
Egzgﬂ gg:t’; coor 09, HP DeskJet 990Cxi, 995C
Epson Stylus Color 2200 HP DeskJet 1125C, 1180C
Epson Stylus Photo 720 HP DeskJet 1220C
Epson Stylus Photo 810, 820, 830, 890 HP Desiclet 3320
Epson Stylus Photo 900 HP DeskJet 3420, 3425
Epson Stylus Photo 1280, 1290 HP Color Inkjet CP1700
Epson Stylus C41UX, C405, C42UX HP LaserJet 1200
Epson Stylus C60, C61, C62 HP LaserJet 2200, 2200d

Epson Stylus C80, C82



Appendix: DP-G310 Printer Compatibility List for Windows (continued)

The Lexmark Printer
Lexmark 4039 10R
Lexmark 5700
Lexmark Optra Color 45
Lexmark Optra C710
Lexmark Optra E, E+, E310
Lexmark Optra K1220
Lexmark Optra M410, M412
Lexmark Optra N
Lexmark Optra R+
Lexmark Optra S1250, S1855
Lexmark Optra SC-1275
Lexmark Optra SE-3455
Lexmark Optra T614
Lexmark Optra W810
Lexmark 253

Other printers from the brands listed above may also be supported.
For an updated compatibility list please visit: http:/AMww.support.dlink.com
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